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Introduction 

NorthClark's Buyer's Workbench and web based Supplier Portal are designed to improve 
communication between Buyers and Suppliers, and streamline the process of obtaining quotes for parts 
and custom engineered components.  Buyer’s Workbench features include: 
 

� Procurement Workflow Management 

� Requisition Maintenance 

� Purchase Order Entry 

� Rules Based PO Routing and Approval Process (optional) 

� Requests for Quote 

� Sealed and Auction Style Bidding 

� Award Based on Price and Supplier Performance Criteria 

� Generate PO/RFQ as Electronic Document and Email to Suppliers 

� Prepare and Email Regret Notices to Suppliers 

� Supplier Performance Tracking (QCD) 

� Contract Pricing 

� View Purchasing History 

� Link Drawings and Other Attachments to a PO or RFQ  

� Maintain All Documents in the BWB Data Store 

� Use with Supplier Portal for Web Based Communication 

 
 Whether your requisitions are generated manually, automatically by the MRP process, or from an 
external application, your Buyers will create purchase orders faster and with greater accuracy using 
NorthClark’s Buyer’s Workbench. 
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Buyers Workbench  

Main Screen 
Work Flow Display 
The Workflow view is displayed when the Buyer’s Workbench Application is launched.  This screen 
provides immediate visibility to tasks requiring your attention, and may be used to navigate to each item.  
 

 
 
When the program is started, the Buyer and Warehouse ID will default to the last entry used.  Use the 
pull-down menus to select the desired Buyer and Warehouse. 
 
The Count for each Things to Do item represents items that may require attention.  The count is 
refreshed automatically according to a user defined time interval (e.g., refresh every 15 minutes).  You 
can set the time interval using the Workflow option found on the Tools menu.  You may also request an 
immediate update by clicking the Refresh button.  If there are no items to be displayed for a given task, 
the count column will be blank and the row will be grayed. If desired, tasks with zero counts can be 
hidden from view by selecting the option, Hide Rows with Zero Count. 
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Clicking the Do Now button activates a search and displays a list of records requiring attention/action 
for the corresponding task. The tasks that are accessible from the Workflow screen include: 
 
� Supplier Requests for Profile Change:  If Supplier Portal is installed, this option will display the 

Supplier Requests view where both Supplier Requests for Profile Changes and Supplier Requests 
for Information may be accessed. 

� Supplier Requests for Information:  If Supplier Portal is installed, this option will display the 
Supplier Requests view where both Supplier Requests for Profile Changes and Supplier Requests 
for Information may be accessed. 

� Open PO Requisitions On Hold:  Populates the Line Items tab with a list of PO Requisitions that 
are on Hold. 

� Open PO Requisitions:  Populates the Line Items tab with a list of all open PO Requisitions. 

� Requisitions Past Start Order Date:  The Start Order Date is the date the item is required, minus 
the part lead-time.  This option populates the Line Items tab with a list of open PO Requisitions that 
have a Start Order Date prior to today’s date.   

� Requisitions – Rejected:  When the Purchase Order Approval feature is enabled, this option will 
populate the Line Items tab with a list of open PO Requisitions that have been rejected during the 
approval process.. 

� Requests for Quotes – New:  This count represents the number of RFQs in New status, though the 
resulting display lists RFQs in New and Open status. 

� Requests for Quotes – Open:  The count represents the number of RFQs in Open status, though the 
resulting Display lists RFQs in Open and New status.  

� Requests for Quotes - Pending:  Displays a list of RFQs that are in Pending or Award status. 

� Purchase Orders to Print/Transmit:  This count represents Purchase Orders that are ready to 
transmit to the Supplier, based on the following criteria: the PO record has been flagged for printing 
by clicking the Print checkbox on the PO Entry tab, the Purchase Order is not on hold, and all 
necessary approvals have been obtained.  When you choose this option, the Batch Purchase Order 
Printing screen is displayed. 

� Purchase Orders - On Hold:  The number of Purchase Orders currently on Hold.  

� Purchase Orders – Late:  The number of Purchase Orders that are past due. 

� Purchase Orders – Approved:  Displays a list of POs that are in Approved status, but not yet 
received. 

� Purchase Orders – Rejected:  Displays a list of Purchase Orders that have been rejected during the 
approval process. 
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� Unposted PO Receipts: Displays a list of POs that have been received, but not yet posted into 
inventory.  This is an error condition.  Use Manfact’s REC.A to post the receipts and receive them 
into inventory. 

� Non-Conforming Notices – New:  Displays a list of NCCAN records that have been created, but 
not yet sent to suppliers for action.  

� Non-Conforming Notices – Pending:  Displays a list of NCCAN records that have been sent to 
suppliers for action, but for which an answer has not been received. 

� Non-Conforming Notice – Open:  Displays a list of NCCAN records that have been reviewed and 
responded to by suppliers and are awaiting closure by the appropriate individual/action. 

� Supplier Messages:  This count represents pending Supplier Performance Notifications, giving you 
the opportunity to approve or reject them before they are sent to the Supplier.  When you choose this 
option, the system will launch the NCC_QCDMsgs application (must be installed separately). 
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Main Menu Options 
Following is a brief description of the options available from the Main Menu of the Buyer’s Workbench 
application. 
 

Menu Option Description 

File Clear  Clear all data on current displays. 

 Save  Save changes/new entries to the database. 

 Print Print the current active spreadsheet.   

 Import Import data from Excel to populate the active spreadsheet.   

 Export Export data from the active spreadsheet.   

 Exit Close the application. 

Edit Copy Copy data to Windows clipboard.  

 Cut Cut data from the field and copy it to Windows clipboard.  

 Paste Paste data from Windows clipboard. 

 Fill Update all of the selected cells from Windows clipboard.  

 Zoom View, print and/or edit the expanded contents of a field.   

 Insert Row Insert a Row above the current position of the cursor. 

 Delete Row Delete the selected Row from the active spreadsheet. 

View Unhide All Columns Expose all columns previously hidden.  

 Auto Fit Columns Automatically adjust the width of each column to 
accommodate your data.  

 Hide Cancelled Rows Cancelled rows will not be displayed. 

 Display Options Set user preferences affecting the appearance of the screen. 

POs Switch to PO Mode Switch to Purchase Order Entry mode. 

 Purchase Order Search Locate Purchase Orders in your system using a variety of 
search criteria. 
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Menu Option Description 

 Copy a Purchase Order Copy information from an existing PO record to create a 
new Purchase Order. 

 Create New PO from 
RFQ 

Use an awarded RFQ to create a new PO. 

 Cancel Entire Purchase 
Order 

Cancel an entire PO. 

 Cancel Remaining Line 
Item Schedule 

Cancel remaining items to be received on a PO. 

Requisitions Switch to Requisition 
Mode 

Switch to Requisition Entry mode. 

 Select Requisitions Locate Purchase Requisitions in your system using a variety 
of search criteria. 

RFQs Switch to  

RFQ Mode 

Switch to RFQ Entry mode. 

 Sample RFQ Mode Create, view or edit a sample RFQ. 

 RFQ Search Locate Request for Quote records in your system using a 
variety of search criteria. 

 Copy from RFQ Copy an existing RFQ to create a new RFQ. 

 Copy from Sample 
RFQ 

Copy a sample RFQ to create a new RFQ. 

 Open Bidding Change an RFQ to open status to begin bidding. 

 Bid Detail Manually enter bid submissions, view or edit bid details. 

 Award RFQ At the close of bidding, award a RFQ. 

 Regret Notices Send Email Regret Notices to suppliers. 

 Refresh Bid Detail Refresh the information on the Bid Detail screen to view 
recently received bids. 

 Reopen an RFQ Reopen a previously awarded RFQ. 
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Menu Option Description 

 Cancel RFQ Cancel an entire RFQ. 

Supplier Maintenance Enter or edit supplier data and supplier history. 

 Notifications Send Email notifications to one, a group or all suppliers. 

 Contract Pricing Enter, edit, search or view Contract Pricing for 
suppliers/parts. 

 Supplier Search Search for suppliers that meet specified criteria. 

Tools Attach Files to PO/RFQ Enter and/or verify attachments to a PO or RFQ. 

 Display Drawing for 
Part number 

Locate and Display a drawing associated with a part. 

 Load Parts to Supply 
(Made From) 

Enter parts to be supplied to a manufacturer of a component. 

 Load Parts to Supply 
From BOM 

Using a Bill of Materials to load parts to supply to a 
manufacturer of a component. 

 Cost History for Part # View cost information for a Part Number including Purchase 
Orders, Receipts, and Quotes. 

 G/L Number Lookup Locate General Ledger Account Numbers in your system 
using a variety of search criteria. 

 Part Number Search Locate Part Numbers in your system using a variety of 
search criteria.   

Note, NorthClark’s Part Number Search application must be 
installed to use this feature. 

 Requestor Lookup Locate a Requestor Name in your system using a variety of 
search criteria. 

 Favorites Store/access line items that are used frequently. 

 System Messages Suppress or allow display of specified error messages. 

 Workflow Set parameters for Buyer’s Workflow display. 

Output Create PO Document Create an electronic Purchase Order Document and file it in 
the BWB Data Store. 
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Menu Option Description 

 View Existing PO 
Documents 

View electronic Purchase Order documents located in the 
BWB Data Store.  The documents may be in either Word or 
PDF format. 

 Create RFQ Document Create electronic Request for Quote documents and file 
them in the BWB Data Store. 

 View Existing RFQ 
Documents 

View electronic Request for Quote documents located in the 
BWB Data Store.  The documents may be in either Word or 
PDF format. 
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Right Click Menu - Row 
When a line item has been selected from the PO, Requisition or RFQ entry mode the following Right 
Click Menu options are available. 
 
Copy Copy data to Windows clipboard. 

Cut Cut data from the current field and copy it to Windows clipboard. 

Paste Paste data from Windows clipboard. 

Fill Update all of the selected cells from Windows clipboard. 

Zoom View, print and/or edit the expanded contents of a field.  

Insert Row Insert a Row above the current position of the cursor.  

Delete Row Delete the current Row from the active spreadsheet. 

Attach Files  Add and/or verify attachments to a PO or RFQ. 

Cancel Remaining Line 
Item Schedule 

Cancel remaining items to be received on a PO. 

Cost History for Part # View cost information for a Part Number including Purchase Orders, 
Receipts, and Quotes. 

Display Drawing for part 
number 

Locate and display a drawing associated to a part. 

G/L Number Lookup Find a General Ledger Accounting number 

Part Number Search Search for a Manfact part number with or without the specific part number. 

Requestor Lookup Search for the name of a Requestor. 

Save Row X as Favorite Save the current row as a favorite for streamlined entry on another record. 
 
 

Right Click Menu – Column 
When a column has been selected from the PO, Requisition or RFQ entry mode the following Right 
Click Menu options are available. 
 
Copy Copy data to Windows clipboard. 

Cut Cut data from the current field and copy it to Windows clipboard. 

Paste Paste data from Windows clipboard. 

Fill Update all of the selected cells from Windows clipboard. 

Sort by Ascending  Sort the selected column in ascending order. 

Sort by Descending  Sort the selected column in descending order. 
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Purchase Orders 
Purchase Order Entry mode is used to create, view and update Purchase Orders.  By default, you will be 
in Purchase Order Entry mode when the program starts.  If you are not currently in this mode, select 
Switch to PO Mode from the PO’s menu.  Note, the modeyou are currently in is displayed in the caption 
at the top of the screen. 
 
Entering a New Purchase Order 

If you were previously viewing an existing record, click the Start New PO button to clear the screen.   

 

 
 

Purchase Order Number Assignment 

There are three methods for assigning Purchase Order Numbers: 
 

Manually Assigned by the User:  Purchase Order numbering is controlled outside the system. 
 
Manfact System Assigned Sequential Numbers:  A sequential number will be assigned by the 
Manfact system when the PO is filed.  Use Manfact’s TABLE.LIID procedure to enabled this option. 
 
NorthClark System Assigned Sequential Numbers with a Prefix:  A list of valid Prefixes is defined 
using the BWB Administration program.  During Purchase Order entry, the user selects a prefix, and 
the NorthClark system assigns the next number for that prefix.  Note, to use this option, Manfact’s 
TABLE.LIID procedure must be used to disable Manfact’s auto-number feature. 
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Using a Reserved Purchase Order Number 

You may reserve a Purchase Order Number for a given Supplier in advance of creating the actual 
Purchase Order.  See the Reserve a PO Number feature on the Tools menu for more information. 
 
When you are ready to use a Reserved PO Number, simply enter it at the PO Number prompt.  The 
system will display a message asking you to confirm that you wish to use the Reserved Purchase Order 
Number. 
 

PO Tab Header Fields 

PO# Prefix If you are using NorthClark System Assigned Sequential Numbers With a Prefix, 
select the Prefix you wish to use from the drop-down list. 

PO Number Purchase Order Numbers may be either manually or system assigned, depending on 
how your system is configured.   

You may access an existing Purchase Order record by entering the PO# here. 

PO Date The date the PO was created. 

Blanket # Identifier of a Blanket Purchase Order record created using Manfact’s POQ.N entry 
procedure 

Vendor Code Enter the Vendor Code used to identify the Supplier. Click on the icon to the right of 
the entry field to access the Locate A Supplier function.  

Remit To Enter the Vendor Code that identifies the Supplier to whom payments will be sent. 

Warehouse The default Ship-To Warehouse for the purchase order is displayed. Use the pull-
down menu to select a different warehouse. This action will change the Ship-To 
Address for the PO. If the Ship-To Warehouse is modified a confirming message will 
appear. Select yes or no to Confirm or deny the change.  

Ship Via Method of Shipment. 

F.O.B. The location where ownership of the goods is transferred, e.g., destination or 
shipping point. 

Freight Freight Terms of payment. 

PO Type  Indicate the type of PO by selecting New, Confirming, or Change.  This setting 
causes the message “Confirming PO” or “Change Order” to be printed on the 
Purchase Order document. 
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Partial Delivery Allow or disallow partial deliveries. 

Early Delivery Allow or disallow early deliveries. 

Print? Check this box to queue this record for batch printing. 

Buyer Select the Buyer ID to be assigned to this purchase order. 

Requestor Enter the Code for the person requesting the item to be purchased. Click on the 
search icon to the right of the field to find the requestor’s code. 

Deliver To Enter the location where this order is to be delivered upon receipt. 

Terms Terms of payment are defaulted from the vendor file. Select a code from the pull-
down list to override the terms of payment. 

Hold Select a hold code, which indicates the reason for the hold, to place the entire PO on 
hold. 

Tax Codes Enter any applicable Sales Tax Codes. 

Currency Select the Foreign Currency Code, if applicable. 

Date to Use Select the Date Code, which will determine when to lock-in the foreign currency 
exchange rate. Used only if a foreign currency code is entered.  

Exchange Rate The foreign currency exchange rate will default from the Currency file only if a 
foreign currency code is entered.  

12 
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PO Addr/Notes screen 
The Addr/Notes screen contains specific Vendor, Ship-To, and Notes information, based on the 
selections made in the PO Display.  
 

 
 

� Supplier Name and Address: Defaults to the Supplier Name and Address in the Supplier File. The 
supplier name and address fields may not be overridden. Use Supplier Entry and Maintenance mode 
to change these fields. 

� Ship-To Name and Address: Defaults to the Warehouse Name and Address in the Warehouse file. 
Any change can be entered directly or search for the Name and Address by clicking on the icon to 
the right of the Ship-To Name field. 

� Vendor Data: You may change the vendor contact, telephone, and fax information with this display.  
Changes made will only apply to the current PO. Use Supplier Entry and Maintenance Mode to 
make permanent changes to Supplier Data. 

� Notes Fields: Any notes to be included on the PO may be entered in the text boxes or use the Note 
Numbers box to enter previously defined Codes. 

� Note Numbers: To add Note Numbers click on the icon to the right of the field and select the notes 
to appear on the PO. The numbered codes were previously defined in the Manfact PURTEXT.N 
function. If Note Numbers have been added to Buyer’s Workbench Administration, the note number 
will default from the Order Type specified on the Line Item. 

� Printed Notes: These notes will appear on the PO. 
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� Internal Notes: These notes will appear only on internal PO documents. 

� Custom Fields:  If your company has defined Header Level Custom Fields for your Purchase 
Orders, these fields will appear in the “Custom Fields” section of this window.  These fields are 
user defined and were created by your System Administrator in the Buyers Workbench 
Administration procedure. Enter the appropriate information for these fields as defined by your 
company's policy. 

 

Purchase Order Line Items Multi-Line View 
 

 
 
There are several ways to add line items to a Purchase Order: 

� From the PO tab click the Load Reqs for Vendor button. The system will load all open requisitions 
for this vendor and switch you to the Line Items Display, where all or any of the items may be 
selected to be included on the PO. 

� To select requisitions using a broader range of selection criteria, use the Select Requisitions option 
from the Requisitions menu. After the search is completed the open requisitions will appear as rows 
on the spreadsheet. Add a requisition item to the PO by clicking on the Add Box next to the 
appropriate line item.   

� If an RFQ has been awarded to the supplier indicated on this PO, the RFQ line items may be added 
to the Purchase Order by entering the RFQ number in the appropriate field. A message will appear 
asking you to confirm loading all Line Items to this PO. 

14 
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�  If a Vendor Quote (POQ) was created in Manfact via POQ.N, the POQ line item may be added to 
the Purchase Order by entering the POQ number and POQ line item number in the fields provided.  
The purchase order quantity will need to be entered.  The unit price will be updated to the quoted 
price as stored in the POQ record.    

� To add a line item that was not previously created via a Purchase Requisition, RFQ, or POQ, type 
the information into the next available blank row or select a Favorite from the Favorites menu 
located in the Tools menu or the Right Click menu.  

 
If the supplier will be manufacturing an item using parts supplied by your company, there are three 
methods available for loading the part number(s) and quantity information: 
 

1. Type the Part Numbers and Quantities in the Parts to Supply column on the Purchase Order. 
2. Copy the information from the “Made From” list entered on the Manfact PARTS file. 
3. Copy the list of Parts from a Manfact Bill of Material (BOM) record. 

 
You’ll find the “Load Parts to Supply” options on the Tools menu. 
 
To remove a line created in error, click the Add box to change the status from a checkmark to a blank 
value.   
 
Different Order Types have different required fields. If you add an item that is missing one or more 
required fields, the system will prompt you to enter the necessary information before the purchase order 
can be filed. 
 
A running total for the "PO Value" will be visible in the status bar.  The total purchase order amount is 
calculated and displayed as you make changes to the order. 
 
Multi-line cells use the Zoom feature for editing.  Double-click on the cell, or click the icon on the 
toolbar to display a pop-up window allowing you to edit multiple lines of information. 
 
Column data may be edited and/or viewed using the Single Item Detail feature. Click the Item Detail 
Button to view the selected line.  Two tabs will be available to view all of the column details.  The fields 
displayed on the Single Item Detail are the same as the columns presented in the Line Item entry, 
although they may be presented in a different sequence. 
 
Once all of the data has been entered, click on the Save to Manfact button to create the Purchase Order. 
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Purchase Order Line Items Single-Line View 
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Column Descriptions: 

Add Add, Delete, or Cancel the entire row. 

This checkbox has three possible values while entering a PO: 

� A green checkmark means the line item has been (or will be) 
included on the order.   

� An empty checkbox is displayed when an item has been loaded, but 
not added to the order. When the purchase order is saved, items with 
a blank value in the checkbox field will not be added to the PO. 

� A red "X" means the line item is to be deleted or cancelled. If no 
receipts have been made against the item, it will be deleted. If 
receipts exist, the remaining scheduled items will be cancelled. 

LI# The line item number is assigned by the system and may not be changed. 
The system will automatically re-sequence the line item numbers if you 
insert or delete lines and no receipts have been made against the PO. 

Requisition # If applicable, the PO Requisition ID Number is the source document for the 
item to be purchased. 

Poreq Date The date on which the PO requisition was generated. 

Req Li# The PO Requisition line item number (Manfact 5.8 and higher) associated 
with the source document for the item to be purchased. 

Requestor The user ID code for the requestor. 

Supplier If the line item you are viewing is a requisition, the suggested Supplier is 
displayed.  Note, if the Supplier Number is different then the one entered on 
the Header of the Purchase Order, a warning message is displayed. 

RFQ # If the PO line item was created from an RFQ, the associated RFQ Number 
is referenced here.  

RFQ Li# If the PO line item as created from an RFQ, the associated RFQ Line Item 
Number is referenced here. In Line Item Detail display this number will be 
in the unlabeled box to the right to the RFQ#. 

POQ# If applicable, the PO Quote ID Number that is the source document for the 
item to be purchased. 
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POQ Li# The PO Quote line item number associated with the source document for 
the item to be purchased. 

Order Type 

 

Using the pull-down window, select the appropriate Manfact numeric code 
for the purchase order: 

1 - Inventory or Production Material shipped to a physical inventory 
location. 

2 - Expense Items charged to a specific General Ledger account. 

3 - Capital Items charged to a specific account. 

4 - Inventory or Production Material received to a specified Work Order     
(A Part Number is Required). 

5 - Inventory or Material that is Drop Shipped from the Vendor/Supplier 
directly to the Customer and is tied to a specific Sales Order. 

6 - Inventory or Material that is Drop Shipped from the Vendor/Supplier 
to another Vendor and is tied to a specific PO.  

7 - Non-inventory Material or costs received into Work Order (No Part 
Number is Required). 

8 - Outside Processing charged to a Work Order. 

Part Number A valid Manfact part number is a required field for Order Types 1, 4, 5, and 
6 purchases. 

Description Description of the part or item to be purchased.  This information will 
default for inventory purchases and may be overridden by the user. 

A pop-up box is displayed when you begin typing in the Description field, 
or when you double-click on the Description cell. 
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Part Hold The Hold Code from the Manfact Parts file is displayed. Hold Codes 
include: 

U - Discontinued, but flagged for "use until exhaust".  

D - Discontinued item, no orders should be recommended. 

O - Obsolete part, should not be issued to work orders.  

Additional Hold Codes may be defined by your company as needed. This 
field is updated by the system and may not be overridden by the user. 

Rev (Revision) Revision Level of the part. This information will default from the Manfact 
Parts file and may be overridden by the user. 

Schedule Dates The scheduled delivery date(s) for the item. When entry or editing occurs, 
an editing window appears, where multiple scheduled deliveries may be 
entered.   

 

Optionally, you may enter a Request Date and a Promise Date for each 
delivery.  If left blank, the system will update these fields with the Schedule 
Date when the PO is filed.  The Promise Date will be used to evaluate the 
Supplier’s performance when measuring on-time deliveries. 

Order Quantity The total quantity ordered is the sum of all scheduled delivery quantities. If 
multiple schedule dates have been entered, this field may not be updated. 
Use the Schedule Dates field to access the editing window. 

Request Dates The date that the item is needed. 
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Change Code Select the Change code from the pull-down menu. The change code is used 
to indicate why a PO line item was changed and whether the change should 
affect vendor performance. Valid Change Codes are defined using the 
Manfact TABLE.PUR procedure. The following Change Notes are 
examples only. 

Change Notes Free form notes to describe the reason for the change to the PO line item. 
Enter the notes into the following editing window. A record of the user, 
date and time will be recorded on each note. 

Balance Due The total quantity remaining to be received. This information is maintained 
by the system and may not be overridden by the user. 

Receipts If Receipts have been posted for a given line item, double-clicking this field 
will open a window showing a list of all Receipt Dates and Receipt 
Quantities for the line item.  

Buy U/M Select the Buy Unit of Measure required by the supplier from the pull-down 
menu.  This unit of measure can be different from the stocking unit of 
measure.  

Buy U/M Factor Enter the multiplier used to convert from the purchasing (buy) unit of 
measure to your company's stocking unit of measure for this part. For 
example, if you stock an item in discrete units (each), but purchase it by the 
dozen, the Buy U/M Factor would be 12. Therefore, when you purchase 1 
package, you will receive 12 units to stock. 

PO Price The unit price for this PO line item. This price must be entered based on the 
Buy Unit of Measure. The system will automatically convert the pricing to 
the equivalent stocking unit price.  

The pricing may be entered in multiples of a single buy unit of measure. 
Entering the appropriate Price Per and Price Conversion factors performs 
this additional conversion. 

Price Per The number of units that the PO Price refers to. The PO price entered for 
this line item will be multiplied by the total quantity and then divided by 
this factor. 

Price Conversion Used to convert the PO price to a factor other than the Buy Unit of 
Measure. This information will default from the Parts file. 

Ext. Price Extended Price = Order Qty * PO Price * Price Conversion / Price Per. 
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Foreign Price As applicable, the unit PO Price in Foreign Currency. 

Tax Type Select a Tax type using the pull-down menu. Tax types are defined in the 
Manfact TABLE.TAX procedure. This information will default to the tax 
type assigned to the part number being purchased but may be overridden. 

Resource Code Select a Resource Code using the pull-down menu. Valid resource codes 
are defined using the Manfact TABLE.WO entry procedure. 

Whse The Warehouse Code identifies the location where materials are to be 
delivered. Select the Warehouse Code from the pull-down menu. 

Project The Project Number will be displayed automatically for purchases to a 
work order or inventory location. For expense and capital purchases, you 
may enter one or more project numbers to be charged with the expense. If 
multiple project numbers are entered, you must also specify the percentage 
of cost to be allocated to each project. 

Work Order The Work Order Number that will receive the material or services. For 
Order Types 4, 7 and 8, specify the WO to be charged. 

InvLoc  Manfact physical Inventory Location identifier. For Type 1 purchase orders, 
you must enter a valid Manfact Inventory Location.  

G/L Account The General Ledger Account Number to be charged for expense (type 2) or 
capital (type 3) purchases. If the G/L Account Number is not known, you 
may access the G/L Lookup feature from the Right Click menu. 

Deliver To Free form user defined name of the location where the item is to be 
delivered. (e.g. Guard Shack, Bob Jones, Loading Dock, etc). 

Last Cost The last actual cost recorded for the part from either a purchase order or 
work order. 

Printed Notes Free form notes to be printed on the purchase order line item. 

Note Numbers Identifiers for user defined notes from Manfact PURTEXT file. The 
associated notes will be printed on the purchase order document. Double 
click on the field to open a window displaying available note codes. Check 
the appropriate box(s) next to the note number(s) to be included on the PO. 
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AML Enter the list of acceptable Manufacturer Names and associated Part 
Numbers.  A pop-up window will be displayed allowing entry of multiple 
lines of information. 

This information defaults from the Manfact PARTS file, but may be 
modified for specific orders if required.  Manufacturer Names must exist on 
Manfact’s MANFR file. 

Ship To Doc. # Ship To Document number: Purchase Order or Sales Order Number. A 
required field when drop shipping directly to a customer (order type 5) or to 
a vendor (order type 6). 

Ship To Line # Line number corresponding to the item on the Ship To Doc. 

Supply Parts? Check this box if your company will supply parts to the vendor for 
manufacture of the item ordered. Once checked, the Outside Processing 
(OP) Location and Parts To Supply information must be filled in. 

OP Location If you are supplying parts to the vendor on this order, a valid Manfact 
outside processing inventory location must be selected from the pull-down 
window.  

Parts To Supply If you are supplying parts to the vendor on this order, enter the list of Part 
Numbers, and the quantity per assembly, to be supplied to the Vendor.  
Refer to the Tools menu for more options available for loading part 
numbers into this field. 

Print? Check the Print? box if you want this line item to print on the Purchase 
Order document. 

A/P Acct# The Accounts Payable account associated with the line item being 
purchased. Defaults from the INVLOC for inventory related purchases and 
from the TABLE.AP for Expense (type 2) and Capital (type 3) purchases. 

Early Days The number of days in which the delivery can be early to the scheduled 
delivery date. Receipts occurring earlier than the days allowed would 
automatically be placed on hold. 

Over Ship % Percentage of acceptable over-shipment. Receipts containing quantities 
more than the allowable percentage will automatically be placed on hold. 
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Hold Code Any entry will place the purchase order line item on hold. Select one of the 
following codes from the pull-down menu: (Blank = "No Hold") 

A  -  Accounting 
C  -  Credit 
E   -  Engineering 
M  -  Manufacturing 
P   -  Purchasing 

Inspect Check the Inspect box if inspection is required upon receipt. 

 
 
Copy a Purchase Order 
This feature allows you to copy information from an existing Purchase Order.  The system will prompt 
you for the PO Number to be copied when you select Copy a PO from the PO’s menu. 

When you are finished editing the order, click the Save to Manfact button.  This will assign the PO 
Number (if applicable), and update the Manfact system with the new information. A confirmation 
message will be displayed indicating the new PO number. 

If you have installed the Purchase Order Approval System, the order will be analyzed to determine 
signature requirements at this time.  See the Purchase Order Approval section for more information. 

 

Create a Purchase Order from an RFQ 
A Purchase Order may be created from an existing RFQ by selecting Create New PO From RFQ from 
the POs menu.   
 
If the RFQ has not been awarded, an error message will be displayed. The PO cannot be created until the 
RFQ has been properly awarded. 
 
 
Modifying an Existing Purchase Order 
You can access in existing Purchase Order either by entering the identifier directly, or by clicking on the 
search icon to the right of the PO Number entry field to access the Purchase Order Search function.  
 
If Purchase Order Approval is installed, you may need to follow the approval processes again for any 
changes that affect the sign-off requirements, such as quantities and/or pricing changes.  
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The following options are presented when the Purchase Order is filed: 
 

 
 
The Buyer’s Workbench allows you to generate the PO as an electronic document, and optionally email 
it directly to your Supplier. Refer to the Output – Electronic Documents topic for more information.  
 
 
Purchase Order Search 
The Purchase Order Search option may be selected from the PO’s menu, or by clicking the icon next to 
the Purchase Order Number prompt on the main screen. 
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Enter your selection criteria, then click the Find button.  You may use as many fields as desired to 
narrow your search, and wildcarding is supported for text fields.   
 
When the search is complete, you will be presented with a list of purchase orders that can be selected for 
review.  Double-click on a row to open a Purchase Order, or if you prefer, highlight the row and click 
the Open button.  
 
To view the electronic Purchase Order Document, highlight the row and click on the View button. The 
document will be located in the BWB Data Store, and will be in either Word or PDF format. 
 
Note that when the search window is closed and reopened, the results of your last search are redisplayed.  
This is a useful feature for selecting and updating groups of records without having to search again and 
again.  However, the information on this display is refreshed only when the search is performed, so care 
should be taken as the data could become stale. 
 
Column Field Descriptions 

Date The creation date for the PO 

PO# The identification number for the PO. 

Supplier ID Number or Code assigned to a specific Supplier. (Vendor ID) 

Supplier Name Name of the Supplier/Vendor 

Whse The Ship To Warehouse(s) for line items on this Purchase Order. 

Status The current status of the Purchase Order: 

� New: There have been no receipts against the purchase order. 

� Backordered: There has been a receipt against the purchase order and there 
is quantity remaining to be received. 

� Closed: All line items have been fully received. 

� Closed and Paid: All line items have been fully received and paid for. 

Buyer The buyer ID assigned to this purchase order 

Next Due Date The earliest due date of an open or backordered line item with remaining quantity 
to be received. 

On Hold If a checkmark is found in this column, there is a “hold” code assigned to either the 
purchase order header or an open or backordered line item. 
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Late If a checkmark is found in this column, there is an open or backordered line item 
that is past due to the scheduled delivery date. 

PO Value The total value of the Purchase Order. 

 
 
Purchase Order Approval 
If you have installed the Purchase Order Approval System, the system will search the rules maintained 
in the Purchase Order Approval System Administration file to determine if the order requires further 
approvals.  If signatures are required, the PO will be placed on hold and the Purchase Order Approval 
Routing Information screen will be displayed. 
 
The procedure will default the routing to the authorized person based on the rules established in 
Purchase Order Approval System Administration.  You may select a different person to route the PO to 
by selecting the name from the drop-down list.  You may also enter notes that will be included in the 
email. 
 

 
 

If you have made changes, click the Save Changes and Close Window button, otherwise just click 
Cancel to close the window. 
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Cancel an Entire Purchase Order 
This command will cancel the entire Purchase Order by setting all order quantities to zero.  If a line item 
has receipts, the order quantity will be reduced to the actual receipt quantity.  To use this procedure: 
 
� Open the purchase order you wish to cancel 
� Select Cancel Entire Purchase Order from the POs menu. 
� Save the Purchase Order 

 
 
Cancel a Selected Line Item 
Use this command to cancel the balance due on a specific line item: 
 
� Open the purchase order you wish to cancel 
� Switch to the Line Items view and click on the row you wish to cancel 
� Select Cancel a Selected Line Item from the POs menu. 
� Save the Purchase Order 
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Requisitions 
Requisition Entry is used for creating, viewing or updating Purchase Requisitions.  All requisitions are 
available for processing, whether generated by the Material Requirements Planning (MRP) system, 
entered manually using POREQ.N, created during Requisition Entry, or posted to Manfact from an 
external source such as a Web based Requisition system. 
 
Multiple requisitions may be viewed and updated at the same time, making it easy to modify groups of 
related requests.  New requisitions may be created, and existing requisitions may be closed at the 
Buyer's discretion. 
 

Create or Update a PO Requisition 
Begin by choosing Switch to Requisition Mode from the Requisitions menu. 
 

 
 
Requisitions may be entered into the spreadsheet in the same fashion as Purchase Order Line items.  See 
the PO Line Item Column/Field Definitions for information on the columns displayed.  The system will 
automatically assign new Requisition Numbers when you click the Save to Manfact button. 

To access an existing record, type the identifier in the Requisition Number column.  You may also 
select a population of Requisitions using the various options on the Workflow tab, or by choosing Select 
Requisitions from the Requisitions menu.   
 
When a row is changed, the line item will be highlighted, indicating that a change has been made but not 
saved.   
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Click the Item Detail button to switch to a single-line view.  The navigator bar in the upper-right corner 
of the screen may be used to scroll through the list of Requisitions: 
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Search for Requisitions 
This screen is displayed when you choose the Select Requisitions option from the Requisitions Menu.   

 

 
 
You may use any combination of the available fields to narrow your search.  For text fields, wildcarding 
may be used to search on a portion of the field.  To exclude a particular field from the search, leave it 
blank or select the “(Not Apply)” option from the drop-down list. 
 
A section has been provided to select the Manfact Order Type Codes that can be used to narrow the 
search.  If you don't select any Order Types, all Order Types will be included in the search.   
 
You may also limit the search to records that have a start order date within the number of days specified 
on the search entry.  The Start Order Date is the latest date the order may be placed and still have the 
parts arrive on time based on the Part Lead Time:  Start Order Date = 1st Schedule Date – Lead Time. 
 
 
Closing/Canceling a Requisition 
To cancel an existing Requisition, click the Cancel checkbox in the first column of the spreadsheet.  A 
large red X will appear in the checkbox and the row color will change to grey.  Click the Save to 
Manfact button. 
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Selecting Requisitions in PO or RFQ Mode 
You must be in “Requisition Mode” to modify or cancel a Purchase Requisition.   
 
Selecting Requisitions in PO or RFQ mode allows you to easily append them to a new or existing 
Purchase Order or Request for Quote.  Clicking the “Add” checkbox while in Purchase Order or RFQ 
mode has the affect of adding or removing the Requisition from the PO or RFQ. 
 

Purchase Order Approval System 
If you have installed the Purchase Order Approval System, the system will search the rules maintained 
in the Purchase Order Approval System Administration file to determine if the requisition requires 
approval.  If approvals are required, the requisition will automatically be placed on hold.  For further 
information regarding the Purchase Order Approval System procedures, see the user guide for this 
application. 
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Requests for Quote (RFQ) 
The Request for Quote Module provides a formal process for soliciting quotations from multiple 
suppliers, and awarding business based on a combination of best price, and supplier performance 
criteria. 
 
This module is closely linked to the Supplier Portal Web Site (sold separately), that allows suppliers to 
place bids on-line.  Whether or not the Supplier Portal is installed, bids may be manually entered using 
the Bid Detail entry screen. 
 

Request for Quote Procedure Summary 
Here is a summary of the normal sequence of steps involved in the Request for Quote process: 
 

� Enter a new RFQ 

� Generate the electronic RFQ document and post to the BWB Data Store 

� E-mail and/or Print RFQ 

� Open Bidding 

� Resolve Supplier Questions – If the Supplier Portal is installed, questions may be received 
electronically from the web site. 

� Enter or Review Bid Detail 

� Select a Supplier and Award the RFQ 

� Send Regret Notices 

� Convert the RFQ to a Purchase Order 

 

Creating a New RFQ 
There are several ways that a new Request for Quote may be created.  You may enter the information 
directly, load Purchase Requisitions, copy from an existing RFQ, or copy from a Sample RFQ.  The 
RFQ tab on the Main screen is used to enter, view, update and award Request for Quotations.   Begin by 
selecting Switch to RFQ Mode from the RFQs menu.   
 
To begin entering a new record, click the New button located at the bottom left of the screen (the system 
will assign an RFQ number when you save the record).   
 
Enter or select appropriate Description, Warehouse, Buyer, and Requestor information.  The RFQ Date 
RFQ Bidding Type and Duration data are selected using the pull-down menus.  If the RFQ Bidding 
Type is Auction, you will need to select the Blackout time and Bid increment. 
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To add a new line item, switch to the Line Items tab, and begin typing on the last row of the spreadsheet.  
You may optionally specify a Purchase Requisition Number, and the system will copy all of the 
available information to the current row. 
 
Another way to add line items is to select a population of Purchase Requisitions using the available 
Work Flow and/or Search features, then append each line item to the RFQ by clicking the “Add” 
checkbox in the first column. 
 
Different Purchase Order Types have different required fields.  If you add an item that is missing one or 
more of these, the system will prompt you to enter the necessary information before the RFQ can be 
filed. 
 
Column data may alternately be edited and/or viewed using the Single Item Detail feature. Click the 
Item Detail to view the selected line.  Two tabs will be available to view all of the column details.  The 
fields displayed on the Single Item Detail are the same as the columns presented in the Line Item entry, 
although they may be presented in a different sequence. 
 
If you plan to furnish material to the Supplier, you will need to enter the list of Part Numbers and 
associated Quantities on the line item.  Options on the Tools menu allow you to load this list using the 
“Made From” information in the PARTS file, or from an existing Bill of Material. 
 
Removing Line Items 

The “Add” checkbox in the first column of the spreadsheet is used to append line items to the RFQ, and 
also to delete line items from an existing RFQ.  Note that a line item may not be deleted if bids have 
already been entered, however you may elect to cancel the line item by setting the Quantity to zero. 
 
Inviting Suppliers to Bid 

The next step is to enter the list of suppliers that will be invited to bid.  You may type the Vendor 
Numbers directly into the spreadsheet, or click the Supplier Search button at the bottom of the screen to 
locate vendor records using a variety of search criteria. 
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RFQ Entry and Maintenance 
This screen is used to create, edit, view, and award Requests for Quote: 

 

 
 
Enter the RFQ Number for the Request for Quote you wish to view or edit.  Click the button to the right 
of the prompt to access the RFQ Search screen. 
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Modify Notes and Ship-To information on the Notes Display: 

 

 
 
This screen contains Ship-To information, and notes to be included with the RFQ.  The Printed Notes 
will be included on the RFQ Document, while the Internal Notes are displayed only on this screen.  Both 
fields accommodate an unlimited amount of free-form text entry. 
 
Note Numbers may be used to add standard text to the RFQ Document.  Note Numbers and associated 
text are entered using Manfact’s PURTEXT.N entry screen.  Click the browse button next to the prompt 
to select from the list of pre-defined Note Numbers. 
 
If custom fields have been created, they will appear on this display.  Enter or update the custom fields as 
required.   
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Modify line item information on the RFQ using the Line Items Display tab: 
 

 
 
Once all of the data has been entered, click on the Save to Manfact button.  At this point, the RFQ will 
have a Status of “New”. 
 
The Open Bidding button changes the RFQ Status to "Open", allowing the selected suppliers to bid on 
the current RFQ.  If the Supplier Portal is installed, Suppliers may review open RFQs and submit bids 
via the web-site.  Otherwise, bids may be entered using the Bid Detail screen. 
 
For auction items, the status is changed to "Pending Award" when the scheduled close date/time has 
passed.  For sealed bids, the status is changed when all invited suppliers have submitted bids, or when 
the close date/time has passed, whichever is earlier.   
 

RFQ Display - Field Descriptions 

RFQ Number The system assigns a sequential identifier when the RFQ is filed. 

Description Enter a description for the Request for Quote. 
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Warehouse The Default Ship To Warehouse for the RFQ.  This information can be overridden 
at the line item level.  Select the correct Warehouse from the drop-down list. 

If the Ship To Warehouse is modified, a message may be displayed “You have 
Changed the Warehouse Code.  OK to Update the Ship-To Address?  A “Y” 
response will cause the address to be updated automatically.  Of course you can 
always verify or change the Shipping Address using the Address/Notes tab. 

Buyer Select the Buyer Code from the list. 

Requestor The individual or department requesting the purchase.  Use the search button to 
select from a list of active employees. 

RFQ Date The creation date for the RFQ.  The system will default to today’s date when 
creating a new RFQ.  

RFQ Type Defines whether the bidding on the RFQ will be by a sealed bid or by an open 
auction.   

Duration The length of time that the RFQ will be open for bidding.  A list of common 
lengths has been provided and can be selected from the drop-down list.   

You are not limited to the selections in the list.  For example, you may enter the 
length and description (for example, 20 Days) and the system will calculate the 
proper scheduled close date for bidding. 

Black Out For Auctions Only.  This is the amount of time where bidding information will not 
be available for view by Supplier Portal users. 

The blackout period is not limited to those listed in the pull-down menu.  If desired, 
you may enter the length and description (for example, 3 Days) and the system will 
calculate the appropriate Blackout Dates. 

Bid Increment For auctions only, you may specify the minimum allowable bid increment.  When a 
Supplier places a bid, it must be better (less) than the current best bid by an amount 
greater than or equal to the Bid Increment.  For example, if the bid increment is 
$5.00, and the current best bid is $100, the next bid must be $95.00 or less to be 
accepted. 

The bid increment is not limited to those included in the list, you may enter any 
dollar amount. 
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Status The current status of the RFQ: 

New:  RFQ has been created but not Open for Bidding 

Open:  RFQ has been Opened for Bidding 

Pending:  Bidding is closed and the RFQ is Pending award. 

Awarded:  The RFQ has been awarded to a supplier but not converted to a 
Purchase Order 

Closed:  The RFQ has been converted to a Purchase Order or Cancelled. 

Open Date The date the RFQ was opened for bidding. 

Open Time The time that the RFQ was opened for bidding. 

Close Date The calculated date that the RFQ will be closed for further bidding. 

Close Time The calculated time that the RFQ will be closed for further bidding. 

Black Date For Auctions Only.  The calculated blackout date where auction information will 
not be visible in Supplier Portal. 

Black Time For Auctions Only.  The calculated blackout time where auction information will 
not be visible in Supplier Portal. 

Award When the RFQ is ready to be awarded, this column may be checked to select the 
supplier that will be awarded the RFQ.  If the award is system selected, this field 
will be updated with a check once the selection has been performed. 

Vendor Number The Supplier Id number for the supplier invited to bid. 

Vendor Name The name of the Supplier. 

Security Level The Suppliers current Security Level.  This value is assigned using the Supplier 
Maintenance screen. 

Q Rating Quality Rating 

D Rating Delivery Rating 

Q + D Rating Combined Quality & Delivery Rating 

Bid Amount Total value of the bid submitted by the supplier. 
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Weighted Cost The Bid Amount is weighted by the Supplier's current Quality and Delivery 
Ratings.  For example, if a Supplier submits a bid of $100, and his composite 
quality and delivery rating is 90%, the Weighted Cost will be (100 / .90) or 
$111.11.   

Schedule Met? Yes or No, depending on whether the Supplier has promised to meet the requested 
delivery date. 

Bid Type How the bid was submitted (e.g., phone, fax, email, web, mail). 

Bid Notes Any notes entered by the supplier on the bid.  If No Bid was submitted, a message 
indicating NO BID will be presented in this field. 

Buyer’s Notes Any notes entered by the buyer on the bid. 

Open PO $ Current value of all Open PO line items for the supplier. 

RFQ View Date The date the RFQ was viewed by the supplier via the Supplier Portal application. 

Submit Date The date the bid was submitted. 

Submit Time The time the bid was submitted. 

 

 

RFQ Notes Field Descriptions 

Note Numbers Note Numbers (Select Note Numbers) 

Printed Notes Free Form Notes that will print on the RFQ 

Internal Notes Free Form Notes that will print on internal RFQ documents only. 

Ship To Name Ship To Name 

Ship To Address Ship To Address 

Custom Fields The System Administrator may add Custom Fields to the application using the 
BWB Administration program. 
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RFQ Line Items - Field Descriptions 
Please refer to the Line Item Field Descriptions topic under the Purchase Order section for a description 
of each column displayed on the line item screen.  The following additional columns are pertinent to 
RFQ Entry Mode: 
 

PO # The Purchase Order Id Number that has been assigned when the RFQ is 
converted to a Purchase Order. 

PO Li# The Purchase Order line item number. 

 
 
Create a Sample RFQ 
Sample RFQ Mode allows you to create Request for Quote examples for training and demonstration 
purposes.   

 
 

Sample RFQs are created from the Buyer’s Workbench in the same manner as a real RFQ.  A supplier 
with level 3 security or above may view the list of samples, view and download drawings, and enter bids 
in the same manner as the actual supplier bidding process.  The Sample RFQ will clearly state that this is 
only a sample, and no actual work will be awarded based on this submittal. 

Although samples are structurally equivalent to a real RFQ and bids, the information is stored in 
separate files so they cannot be confused with legitimate orders.  The Sample RFQ is useful for both 
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evaluating potential suppliers, as well as training current suppliers who are new to the Supplier Portal 
application. 
 
While actual RFQs are only visible to those suppliers whom the Buyer has invited to bid, sample RFQs 
are available to be viewed by all suppliers.  Sample RFQs remain open until the close date and time 
specified by the Buyer.  A Buyer may specify a close date far into the future in order to keep the sample 
open indefinitely. 
 
 
Search for RFQs 
Choose the RFQ Search option from the RFQs menu on the main screen, or by clicking the search 
button next to the RFQ Number prompt on the RFQ Display screen.   

 

 
 
You may fill in as many or as few of the fields as you wish to narrow your search.  Wildcarding is 
supported for text fields. 
 
You may select any combination of the following RFQ Status options, and you must select at least one: 
 

New/Open  - RFQ’s that have a status of New or Open for Bidding 

Pending/Awarded  - Bidding is closed, and the RFQ is either waiting to be awarded or 
converted to a Purchase Order. 
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Closed  - Request for Quotes that have either been converted to a Purchase 
Order or cancelled. 

 
Once the search criteria have been entered, click the Find button.  To open an RFQ, double-click on the 
desired row, or if you prefer, highlight the row and click the Open button. 
 

Column Descriptions: 

Date The creation date for the RFQ 

RFQ# The identification number for the RFQ. 

Description Description of the Request for Quote 

Categories You may limit your selection based on the Part Category assigned to the RFQ line 
item. 

Whse The Ship To Warehouse(s) for line items on this RFQ. 

Buyer The buyer id assigned to this RFQ 

RFQ Type Sealed Bid or Auction 

RFQ Status The current status of the RFQ: 

New:  The order has been entered but not opened for bidding. 

Open:  The RFQ has been opened for bidding. 

Pending:  The RFQ is closed for bidding, and pending award by the Buyer. 

Awarded:  All bids have been recorded and a Supplier has been selected. 

Closed:  The RFQ has been closed and converted to a Purchase Order. 

Open Date Date RFQ was open for bidding 

Open Time Time that the RFQ was opened for bidding 

Close Date The date the RFQ was closed to further bidding. 

Duration The amount of time that the RFQ was open for bidding. 
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Copy from an Existing RFQ 
This feature allows you to copy information from an existing RFQ record.  The system prompts you for 
the RFQ Number to be copied, then loads all available information into the current record.  A new RFQ 
Number will be assigned when you Save the RFQ. 

 
Copy from a Sample RFQ 
This feature allows you to copy information from an existing Sample RFQ to a regular RFQ.   
See: Create a Sample RFQ for more information on creating Sample RFQs. 

 
Open Bidding 
The Open Bidding Command changes the status of the RFQ to "Open", indicating that bids may now be 
accepted.  If the Supplier Portal is installed, the RFQ will be available for Suppliers to view, download 
drawings, ask questions, and place bids.   
 
Click on the Open Bidding button at the bottom of the RFQ or select Open Bidding from the RFQ Menu 
option.  The RFQ will be updated with the Open and Close Date(s) and Time(s). 
 
Each RFQ will have a type code identifying it as either an “Auction” or a “Sealed Bid”.  To submit a 
bid, the supplier must enter a price and a promised delivery date for each part on the RFQ.  Submitted 
bids are posted to the NCC_RFQBID file.  The Supplier Portal displays real-time status of active 
auctions including current “best bid”. 
 
If the Supplier does not have access to the Supplier Portal application, they may submit their bids via 
traditional methods such as phone, e-mail, fax or mail.  Bids that have not been submitted online can be 
entered via the RFQ procedure by clicking Bid Detail. 
 
Once the RFQ has been opened for bidding, be sure to Save the record by clicking on the Save icon 
located on the Toolbar. 
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Displaying Bid Detail 
Clicking the Bid Detail button on the RFQ Display or selecting Bid Detail from the RFQ Menu accesses 
the Bid Detail Screen, shown below.  Use the Navigation Bar on the upper-right corner of the screen to 
scroll through the bids for each Supplier listed on the RFQ. 
 

 
 
Manual entry of bid information is available for email, fax, telephone, or mail submissions.  Bid 
submissions made via the Web will automatically update from the Supplier Portal application.  Select 
the Submit Method from the pull-down menu, enter the submit date and time and any notes provided by 
the supplier.   
 
If the supplier has chosen not to bid, click on the No Bid box to indicate that the supplier is not 
submitting a bid.  A message will be presented confirming that the bid prices will be set to zero.   
 
Enter the Suppliers promise date and quoted unit price for each line item.  The system will automatically 
calculate the extended price.  Save the bid by clicking on the Save icon located on the Toolbar.  A 
message will be presented indicating that the bid was filed. 
 
 
Column Descriptions: 

RFQ Number RFQ ID Number 

Supplier Supplier ID and Name 
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Security Level Supplier Portal Security Level 

Open PO $ Current Open PO Value for Supplier 

Quality Rating Supplier Quality Rating 

Delivery Rating Supplier Delivery Rating 

Q+D Rating Weighted Quality and Delivery Rating 

RFQ View Date Date Supplier viewed RFQ 

RFQ View Time Time Supplier viewed RFQ 

Bid Amount Total RFQ Bid Amount for All Line Items 

Weighted Bid Total Bid Amount divided by Q&D Rating 

Schedule Met Did Supplier commit to promise date that meets the schedule date.  Yes or No. 

Submit Method Bid Submittal Method 

    E  -  Email 
    F  -  Fax 
    M  -  Mail 
    P  -  Phone 
    W  -  Web 

Bid Submit Date Date bid was submitted 

Bid Submit Time Time bid was submitted 

No Bid If checked supplier declined to bid. 

Bidder’s Notes Free Form Notes from bidder 

Buyer’s Notes Free Form Notes from buyer 

Part Number Part Number being bidded on 

Description Description of item being bidded on 

Category Product Category of Part 

Request Date Requested Date for delivery 

Quantity Quantity Requested 
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U/M Unit of Measure 

Promise Date Bidder’s Promise Date 

Unit Price Bidder’s Unit Price 

Ext Price Bidder’s Extended Price 

Contract Price? Does a contract price exist?  Yes or No 

 
 
Once bids have been entered the header screen will be updated as illustrated below: 

 
 

 
 

Once all of the bids have been recorded, or the bidding is closed, the RFQ will be ready to award. 
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Awarding an RFQ 
When you are ready to Award an RFQ, click the checkbox in the Award column next to the selected 
Supplier, then click the Award button.  If you click the Award button without selecting a Supplier, the 
system assumes you want the lowest quote.  A message box is displayed to confirm you choice. 
 

 
 
After awarding the RFQ you will be prompted to Send Regret Notices.  Please refer to this topic for 
more information. 
 
Select Create New PO From RFQ from the PO’s menu to convert the Request for Quote to a Purchase 
Order. 
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Award to Multiple Suppliers (Split an RFQ) 
When a Request for Quote has multiple line items, it may be that the most cost effective option is to 
award the business to more than one Supplier.  While the Buyer must take into account other 
procurement costs such as purchase order processing and shipping charges, the Award to Multiple 
Suppliers display makes it easy to determine the lowest unit cost based on the bids submitted .   
 

 
 
The upper grid displays one row for each line item on the RFQ, with each Supplier’s bid displayed as a 
column on the spreadsheet.  The yellow highlighting marks the currently selected bids.  The lower grid 
displays a summary showing the number of items and dollar values to be awarded to each Supplier. 
 
When the screen is initially displayed, the system will have pre-selected the best price for each part 
number.  When you click on any cell, that Supplier’s bid becomes the selected cost, and the totals are 
updated accordingly.  Click the Reset to Lowest Price button at any time to return to the default best 
price selections. 
 
When you click Split RFQ Now, the system will create two or more new RFQ records, depending on the 
number of Suppliers included in your selection.  In the above example, the first two rows would be 
copied to RFQ# 27-1 and the last two rows would be copied to RFQ# 27-2.  All of the bid information is 
automatically copied to the new RFQ records, and the original RFQ is cancelled. 
 
Once the new RFQ records are created, they can each be awarded separately and converted to Purchase 
Orders.  Note that this method of splitting an RFQ for the purpose of awarding to multiple suppliers 
allows the system to maintain accurate bid history and win/loss statistics. 
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Restore a Split RFQ 
If you split a Request for Quote (see Award to Multiple Suppliers), then later change your mind, the 
Restore a Split RFQ option will allow you to restore the RFQ to its pre-split condition.  All RFQ 
records that were created as a result of the split are automatically cancelled, and the quantities are 
restored to the original RFQ record. 
 
 
Sending Regret Notices 
After the RFQ is awarded, you will be presented with a message asking if you want to send regret 
notices to the suppliers that did not win the bid.  You may also access this screen from the RFQs menu. 
 

 
 
The default regret message is defined in the BWB System Administration application and may be 
modified here as desired.   
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The list of Suppliers who will receive notification is displayed on the second tab: 
 

 
 
Refresh Bid Detail 
If you have been viewing an RFQ on your screen for a period of time, it is possible that bids may have 
been received via the Supplier Portal Web Site in the meantime.  Choose the Refresh Bid Display option 
to ensure you are viewing the most up to the moment bid information. 
 
Note, the bid information is always current at the moment you access an existing RFQ record, so it is not 
necessary to choose this command if you have just accessed the record, or if bidding was closed prior to 
accessing the current record. 
 
 
Reopen an RFQ 
An RFQ may be reopened after it has been awarded.  Access the desired RFQ record in the RFQ 
Display, then select Reopen an RFQ from the RFQs menu.  Be sure to update the Close Date and Time 
or the RFQ may close again when filed.  Save the record to Manfact. 
 
 
Cancel an RFQ 
This command will cancel the entire RFQ.  Note, cancelled RFQs are not visible from the Supplier 
Portal Web Site.   To cancel an RFQ enter the desired RFQ number in the RFQ Display.  Select Cancel 
RFQ from the RFQs menu.  Save the record to Manfact. 
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Suppliers  
Supplier Requests (from Supplier Portal) 
Use this view to reply to Supplier Requests for Information and Supplier Requests for Profile Changes.  
These requests are submitted by Suppliers using the Supplier Portal Web Site.   
 

 
 
Requests for Information always pertain to a specific Request for Quote (RFQ) Number.  The Supplier’s 
questions may be submitted from the Bid Entry page on the Supplier Portal Web Site.  From the Buyer’s 
Workbench, you can review and answer these questions, email your answer to one or all of the Suppliers 
on the RFQ, and optionally post your answer on the Supplier Portal Web Site where it may be viewed by 
all Suppliers who have been invited to bid on the RFQ. 
 
Requests for Profile Change  may be submitted by the Supplier at any time to update their company 
contact and profile information.  You will have the opportunity to review these requests, make 
adjustments if necessary, and then automatically update your database (VENDOR and NCC_VENDOR 
files) with the revised information. 
 

The Search Display 
This view may be accessed from the Workflow display, or by selecting Requests from the Supplier 
menu.  If you selected one of the Workflow options, the list of requests awaiting your attention will be 
automatically displayed.  Otherwise, you may enter any combination of the available selection criteria to 
locate existing records. 
 
To open a Request for editing, double-click on the desired row.  You may also highlight the row and 
click the Open button. 
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The Profile Change Display 
Current Supplier Profile values and requested values are displayed, and changed values are highlighted.  
You may Accept or Reject the changes by clicking on the appropriate button.   
 

 
 
If you want to accept a portion of the change, or make minor modifications to the record, this can be 
accomplished by entering the correction in the “New Value” column.   
 
If the change is rejected, the NCC Supplier Request Profile Change file is updated as “Denied”.  This 
record can still be viewed by requesting “Closed” records.  A Denied request can be accepted later if 
needed.   
 

Creating a New Supplier Profile 

A Request for Profile Change may be received from a Supplier who is not yet defined as a Manfact 
Vendor.  A new login id would have been created in Supplier Portal Administration, without a reference 
to a Supplier ID number.  This allowed the new supplier access to request or submit information via the 
Supplier Portal applications. 
 
If Vendor Numbers are system assigned, (per Manfact’s TABLE.LIID procedure) the system will assign 
the next sequential Vendor Number. Otherwise, you will be prompted for the new Supplier ID.  When 
the new Supplier record is created, the system will automatically promote the Security Level to "4" and 
update the Supplier Portal Administration files with the new Supplier Id. 
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Requests for Information 
Use this screen to view and post answers to requests for information received from the Supplier Portal 
Web Site. 
 

 
 
Once you have typed your answer, click the checkboxes to determine how this information will be 
disseminated: 
 

Make Public Makes this question and answer visible on the Supplier Portal Web 
Site.  All Suppliers who were invited to bid on the RFQ may view 
the information. 

Email This Supplier Sends an Email message to the Supplier who asked the question. 

Email All Suppliers on This RFQ All Suppliers who were invited to bid will receive an email. 

 
If you have selected one of the options to send email, the Supplier Notifications screen will be displayed 
when you click the Submit Answer button.  The process of sending email messages to a group of 
Suppliers is discussed in the next section. 
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Supplier Notifications 
Use this procedure to send an email notification to a selected group of Suppliers.   
 

 
 
You may access this view from the Supplier menu, or you may arrive here after responding to a 
Supplier Request for Information.  Complete the email tab by entering the Subject Line, Message, and 
add any attachments as required.  If a notification receipt is needed, be sure to check the Request 
Notification of Receipt box.  Use the Supplier tab to create a list of Suppliers that will receive the 
Notification.  The Supplier Search procedure is available to locate Suppliers.  Click the Send button to 
send the E-mail. 
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Contract Price Entry and Maintenance 
Use this screen to add, search, view and maintain Contract Pricing information for specific Suppliers 
and Part Numbers.    
 

 
 
Use any combination of the available search criteria to locate existing records.  To create a new record, 
begin typing in the last  row of the spreadsheet.  To delete a record, click the checkbox in the Del? 
Column.  You must click the Save icon on the toolbar before any of your changes or deletions will take 
affect. 
 

Column Definitions: 

Supplier Id The supplier (vendor) identifier. 

Part Number The part number for the contract item. 

Contract Price The unit contract price. 

Minimum Quantity The minimum quantity that must be purchased for the pricing to be in effect. 

Unit of Measure The Buy Unit of Measure.   

Unit of Measure 
Factor 

Conversion Factor to convert Buy U/M to Stocking U/M 

Contract Number The suppliers assigned contract number. 

Effective Date The start date that this contract becomes effective. 

Expiration Date The end date of this contract. 
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Locate a Supplier 
Use this screen to locate a Supplier record using various search criteria.  This screen may be accessed 
from numerous locations throughout the Buyer’s Workbench, including the Suppliers menu on the Main 
screen. 
 

 
 

Note, a performance rating of –100 indicates there is no data available for the Supplier. 
 
Use as many or as few fields as you want to narrow your search.  If you don’t know the exact spelling of 
the supplier name, you can use wildcarding to enter only a portion of the name.  Press the Search button 
to begin searching the Manfact database for the suppliers that meet your criteria.   
 
In some cases, it will be appropriate to select more than one Supplier from the list, such as when you are 
inviting suppliers to bid on an RFQ, or sending email notifications to a group of suppliers.  In these 
cases, a checkbox will appear in the first column of the spreadsheet.   
 
To select multiple suppliers, check the desired rows, then click the Select button.  To select a single 
supplier, double-click on the desired row, or highlight the row and then click the Select button. 

Column Descriptions: 

Code Supplier ID Number that has been assigned to this record. 

Name Supplier Name 

Q Quality Performance Percentage.  Note, a rating of –100 indicates there is no  
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D Delivery Performance Percentage  

Q + D The combined Quality & Delivery Performance Percentage.   

Level Supplier Portal Security Level 

Phone The contact Phone Number 

Contact The contact name 

Address A right click will present the full address for this supplier. 

Notes A right click will present all notes recorded for this supplier. 

Fax The contact Fax Number 

Email The contact Email address 

Hold Code The hold code for a Vendor. 

    Q     RFQ and Quote type transactions (POQ.N)                              
    B     Blanket Purchase Orders (POQ.N)                                      
    P     Purchase Orders (PO.N)                                               
    R     Purchase Order Receipts (REC.N, REC.A)                               
    I     Accounts Payable Invoices (AP.N)                                     
    C     Accounts Payable Checks (CHECKS.SET, CHECKS.N)                       
    A     Enable All the above hold codes 
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Tools  
Attach Files to PO/RFQ 
Use this screen to view or update the list of electronic files attached to a Purchase Order or Request for 
Quote.  You may attach virtually any type of file, including drawings, spreadsheets, documents, etc. 
 

 
 
You may attach multiple files to each Purchase Order or RFQ line item.   
 

� Click on the desired row to highlight it, then click the Attach File button to browse your 
network.. 

 
� Click AutoFind to locate drawings associated with the Part Number.  The system will search for 

drawing files using standard naming conventions.  Please refer to the Displaying a Drawing for 
a Part # topic for more information on how the system locates these files. 

� The Detach File button will disassociate the current file from the selected line Item. 

� Click View Attachment to see a full size rendering of the file. 

� Click Done to apply the changes you have made. 

When the Purchase Order or Request for Quote is filed, a copy of each electronic attachment will be 
placed in the BWB Data Store.  This makes the information centrally available for viewing and 
emailing.  Various applications, including the Supplier Portal Web Site, will have access to the PO or 
RFQ Document and all of its associated attachments. 
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Displaying a Drawing for a Part # 
Use the screen below to enter the Drawing Number, Part Number, and Revision Number for the drawing 
you wish to see. 
 

 
 

How the System Locates a Drawing: 

When you choose the Display Drawing option, the system searches for an image file and then displays 
the drawing using the image viewing software associated with the file type.   

The search begins at the first "root" folder for your Warehouse, as defined by your System 
Administrator.  Each root folder is searched as follows: 
 

� First, the system looks for a folder name matching the Project Number.  If found, the search 
continues within the Project folder.  Otherwise, the search continues from the root folder. 

 
� Next, the system looks for a folder name matching the Part Number.  If found, the search 

continues within the Part Number folder.  Otherwise, the search resumes from the root or Project 
folder located in the previous step. 

 
� Finally, the system attempts to locate the image file, using a combination of Part Number and 

Revision Level.  For example, the image file for Revision B of Part Number 12345 would be 
called "12345RB.*". 

 
� If the system is unable to locate the file using these search rules, a dialog box will be displayed 

and you will be given the opportunity to browse for the file yourself.   
 

� Once located, the part is displayed using the image viewing software associated to the file type. 
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Reserve a PO Number 
Sometimes it may be necessary to give a Purchase Order Number to a Supplier in advance of creating 
the actual Purchase Order document.  For example, you may be placing a phone order, and plan to 
follow-up with a confirming document later.  Select Reserve a PO Number from the Tools to display 
this view: 
 

 
 
Use the Find button to locate existing Purchase Order Number Reservation records.  If you are using 
Prefixes as part of your PO numbering scheme, you may select one from the drop-down list to narrow 
your search.  You may also enter a list of Suppliers (separated by commas) to include in the search.  
Click the icon to the right of the Supplier prompt to access the Locate a Supplier function. 
 
To Reserve a new PO Number, begin typing in the last row of the spreadsheet.  Select the Prefix if 
applicable, and enter the Supplier Number along with any Notes describing the reason the PO# is being 
reserved.  When you click the Save to Manfact button, the system displays your new PO Number in the 
Reserved PO# column. 
 
To delete a record, click the checkbox in the first column.  The record will be deleted after you click 
Save to Manfact. 
 
When you are ready to create the actual Purchase Order, simply follow the instructions for Entering a 
New Purchase Order, and enter the Reserved PO# at the PO# prompt. 
 
 
Loading Parts to Supply (Made From) 
If the supplier will be manufacturing an item using parts supplied by your company, you will want to list 
the part numbers and associated quantities to be shipped.  The "Made From" part numbers and quantities 
can be entered in the Manfact system using the PARTS.EN or PARTS.ALL entry procedure. 
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When you select the Load Parts to Supply (Made From) option, the parts and quantities will be 
automatically loaded into the Parts to Supply field.  The information contained in the fields can be 
updated as required. 
 
 
Loading Parts to Supply from BOM 
If the Supplier will be manufacturing an item using parts supplied by your company, you may include a 
list of parts to supply with the Purchase Order.  This option allows you to load the list using an existing 
Manfact Bill Of Material record.   
 

 
 
� Select the file from which to load this data.  You may use a Production BOM, an Engineering 

ENGBOM (requires ECO Number), or a Work Order WOBOM (requires WO Number). 

� Enter the Assembly Number.  If you have the Part Number Search application installed you may 
launch the Part Number Search feature by clicking the icon to the right. 

� When multiple BOM files exist for the same assembly, you may need to specify a Plant. 

� Check the box if you wish to Explode the Bill of Material beyond First Level. 

� Set the Effective Date.  The system will default to today's date. 

� If the Bill of Material Line Item contains an “AR” (As Required) in the quantity field, you must 
enter a quantity to use for the purchase order.  

� When you have entered all necessary data, Click OK to load the BOM data. 
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Part Cost History 
Selecting Part Cost History from the Tools Menu accesses the following screen.  It displays a list of 
recent purchase orders and receipts for a selected part number. 
 

 
 
� Enter the Part Number or use the pull-down menu to select a part number.  Part Numbers currently 

included on the PO, RFQ, or PO Requisition line item display will be included in the list, or you may 
type any valid Part Number.   

� Decide if you wish to include Open Purchase Orders, Receipts, or Quotes in the list.  You must 
select at least one of these. 

� You may enter a date range by clicking the appropriate checkbox(s) and entering the desired date(s).  
The 'To Date' defaults to today’s date when searching.  Note: the search is performed on the date the 
PO/Quote was filed. 

� Click the Search Button when you are ready to search.  A message will be displayed indicating that 
the search is being performed. 
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Column Definitions: 

Type The source of the transaction 

PO = Receipt against a Purchase Order 

Quote = A quotation entered on a Request for Quote (RFQ) 

PO/RFQ Date The creation date for the PO or RFQ 

DOC# The identification number for the PO or RFQ 

LI# The line item ID # assigned to the Receipt or RFQ item being reported 

Supplier 
Number 

Number or Code assigned to a specific Supplier. (Vendor ID) 

Supplier Name Name of the Supplier/Vendor 

Order/RFQ Qty The total quantity ordered is the sum of all scheduled delivery quantities for the line 
item. 

Qty Received The total quantity received is the sum of all the receipt quantities for the line item. 

Unit Price The unit price entered on the PO or Quote.  The unit price does not reflect any 
changes to price that may have occurred during Accounts Payable processing 

Resource The resource code assigned to this PO or RFQ line item.   

Work Order# The work order number that the Receipt or RFQ line item is being assigned to. 

Line Notes Notes entered against this specific PO or RFQ line item.  This field will contain the 
word “NOTE” if there is a line item note.  Click on this field and the note will be 
displayed. 

Change Notes Change notes entered against this specific PO line item.  This field will contain the 
word “NOTE” if there is a line item note.  Click on this field and the note will be 
displayed. 

Cost Group Cost Group used for Part Cost History Information 

Hist. Average Historical Average for the Cost Group 

Last Cost Last Cost for the Cost Group 
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Looking up a G/L Number 
Use this option to locate a General Ledger Account number.  This view is accessible from the Tools 
menu, or by right-clicking on the G/L field during line item entry.   
 

 
 
 
 
Part Number Search 

The Part Number Search Query helps you locate a Manfact Part Number using a variety of search 
criteria.  Please see the Part Number Search Query User Guide for more information. 

Note:  The NCC Part Number Search Query is sold and installed separately.  If this option is not 
currently available, please contact your System Administrator or NorthClark Computing, Inc. to obtain a 
copy of NCC_PARTSQ. 
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Looking up a Requestor 
You may access this view from the Tools menu or by right-clicking on the Requestor field during line 
item entry.   
 

.  
 
The information on this display comes from Manfact’s “OPER” file.  You may narrow the list by 
entering all or part of the person’s name at the Description prompt. 
 
Create and Maintain PO/RFQ Favorites 
The favorites feature allows the user to store line items that are used frequently.  This eliminates the 
need for repetitive entry of the same information and facilitates the streamlining of entry procedures.  
This view may be accessed from the Tools menu, or from the Right-Click Menu during line item entry. 
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This screen serves multiple purposes.  You can: 
 

� Create new “Favorite” records 
� Locate and update existing records 
� Select items from the list to append to a Purchase Order or Request for Quote 

 
Favorites may either be Global or Personal.  Global Favorites are available to all users of the system, 
while you may create Personal Favorites for your own exclusive use.  Note, you must have System 
Administration privileges to update Global Favorites.  Select one of the following at the User Name 
prompt, where UserName is your personal login identifier: 

(Show All) Selects the entire NCC_BWB_FAVS file.   

(Global) Create or Select Favorites that will be available to all users of the system. 

UserName To create Personal Favorites, select your login name. 

(Global), UserName Selects you personal Favorites, plus any Global Favorites that are on file. 

 

The Price Method defines how the system will update the pricing on a Purchase Order when the 
Favorite is selected.  Choose from one of the following options: 
 

� None - The system will use default pricing 

� Unit Price - The price entered on the Favorite record 

� Percent of Order - Calculate the price based on the total order value up to the Not to Exceed 
amount entered on the Favorite record. 

Create a New Favorite from an Existing Line Item 
You can easily create a new favorite from an existing line item by clicking on the line item, then right 
clicking the mouse and selecting the option “Save Row X as Favorites”.   The new record will be 
created as a Personal Favorite. 
 

Deleting Favorites 

Favorites that are no longer needed can be deleted by clicking on the “Delete Favorite” checkbox.  This 
will cause the row to turn red.  The record will be deleted from the file after you click the Save button. 
 

Adding a Favorite Line Item to a PO or RFQ 
Select Favorites from the Tools menu.  Check the select box next to the line item you wish to add to the 
PO or RFQ.  Click on the Update PO/RFQ with Selected Favorites button. 
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System Message Maintenance 
System Message Maintenance allows you to control whether certain standard error messages are 
displayed or not.  If you do not wish an error message to display simply place a check in the box 
provided. 
 
These settings are stored in the Registry, so each user may set their own preferences. 
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Setting Workflow Parameters 
Select Workflow from the Tools menu to enter options that affect the Buyer's Workflow Display. 
 

 
 

Workflow Last Updated The system displays the date and time when the workflow 
counts were last refreshed. 

Update Workflow Counts When 
Program Starts 

Check this box to refresh the counts automatically on startup. 

Enable Automatic Workflow Updates Check this box to allow the system to automatically refresh 
the counts at specified time intervals 

Update Interval The number of minutes between automatic count updates. 

Play a Sound When New Work Arrives Check this box to have the system play a sound anytime the 
workflow counts change. 

Sound File Use the browse button to locate a sound file. 
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Output – Electronic Documents 
The Buyer’s Workbench may be used to create electronic Purchase Orders and Request for Quote 
documents.  These files may be deposited in the BWB Data Store, where they may be viewed by internal 
personnel, emailed from the Buyer’s Workbench, or downloaded from the Supplier Portal Web Site. 
 
The PO or RFQ is initially created as a Microsoft Word™ document, and may optionally be converted to 
a PDF file.  Note, you must install Adobe Acrobat™ if you wish to created PDF files. 
 
The format of the document is dictated by a Microsoft Word Template, along with a variety of settings 
your System Administrator can control through the Buyer’s Workbench Administration procedure.  
Standard templates are delivered as part of the NorthClark solution, and may be modified to include 
your company’s logo, color choices, and other preferences.  
 
In addition to the electronic document, you may also output the information in the form of an Excel™ 
spreadsheet.  If your supplier’s system supports importing data from Excel, they may appreciate being 
able to load the information directly into their system without having to re-key the information.  For 
Purchase Orders, the Excel Workbook will also include a Packing List and Labels the supplier may 
choose to print for shipping purposes.   
 
Options for Creating Electronic Documents 
The options defined in this section are common to all three modes of electronic document processing: 
 

� Individual Purchase Orders 
� Batch Purchase Order Processing 
� Request for Quote  

 
To locate the Template Path and Template Name, click the browse button located next to the 
Template Name field.  This will initiate a standard browse function that will help you locate your PO or 
RFQ template.  Once you've located the template the first time, the system will remember your entries, 
and you will not need to find it again in the future.   
 
The Save in Folder Name and Document Name prompts determine where your finished document will 
be stored.  If your company has implemented the BWB Electronic Data Store, these values will be filled 
in by the system and may not be changed.  Otherwise, you may specify a folder on your network or local 
hard drive where you want the files to be saved. 
 
If you want to preview the document before printing, check the box next to Display Word Document 
When Created. 
 
If you want to print or email the document without previewing, check either the box next to Print Word 
Doc Automatically When Created or E-Mail Word Doc Automatically When Created. 
 
If you would prefer to send the PO or RFQ as an Adobe Acrobat PDF file instead of a Word document, 
choose the option to Create PDF When Word Doc Posted.  Please refer to the Technical Notes below 
for more information. 
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If you select the Generate Excel Worksheet When Created option, the system will automatically 
create a new Excel Spreadsheet containing the line item data from the PO or RFQ, which may be 
attached to the email you send to your Supplier.   
 
Data is loaded into the Word Document using Field Codes that have been embedded in the template 
(this concept is similar to creating Word templates for mail merge applications).  You may change the 
location where data is printed on the form by moving the appropriate Field Code on the template.  Click 
the View List of Word Field Codes button to view a list of fields that may be included in your Word 
Document. 
 
Review the information on the Email tab.  Use this tab to enter the recipient's email address, edit the 
subject line text, edit messages for the body of the email, and edit the list of files to be attached.  Email 
addresses default according to the entries made in the Supplier Maintenance screen.  The message in the 
body of the email defaults according to the entries made using the Buyer's Workbench Administration 
utility. 
 
There are two ways to attach files to the email: 
 

o If you have attached drawings or other files to individual PO/RFQ line items using the Attach 
Files feature on the main screen, a list of these files will be displayed in the grey text box near 
the bottom of the E-Mail Tab.  Click the Send All Files Attached to This Purchase Order 
option to include these files in your email transmission. 

 
o In the center of the screen, you will find a text box labeled Attach.  Use the Browse button to the 

right of this area to locate any additional files you wish to send. 
 
Note, email attachments may be sent as a WinZip file (see Technical Notes below for more 
information). 
 
If you have never sent email before, you will want to update your Email Options, by selecting Display 
Options from the View menu on the main screen.  Please refer to the Email Options topic in the General 
Information section of this document. 
 
If you plan to print the document(s), use the Properties button to select a Windows Printer. 
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Creating a Purchase Order Document 
This option may be selected from the Output menu, or by clicking the Email or Print PO button on the 
Purchase Order Header (PO) tab of the main screen. 
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Creating an Excel Spreadsheet 
This is an example of an Excel Workbook that may be generated along with the electronic Purchase 
Order document.  The Workbook contains three spreadsheets: PO Data, Packing Slip, and Labels. 
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Batch PO Document Processing 
This option allows you to select a population of Purchase Order records, and create electronic 
documents for the entire batch all at once.   
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View a Purchase Order Document 
This option allows you to view electronic documents that currently reside in the BWB Data Store.  This 
option is available on the Output menu of the main screen, and is also accessible from the Purchase 
Order printing screens. 
 
If there is more than one revision of the Purchase Order on file, you will be prompted for the Change 
Level to print.  This prompt defaults to the latest revision.   
 
The document will be displayed in either Word or PDF format, depending on the options chosen at the 
time it was created. 
 

 
Creating a Request for Quote (RFQ) Document 
Use this screen to generate Request for Quote documents.  One electronic document will be created for 
each Supplier invited to bid on the RFQ. 
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Creating an Excel Spreadsheet 
This is an example of an Excel spreadsheet that may be generated and sent along with the electronic 
Request for Quote document: 
 

 
 
 
Viewing an RFQ Document 
This option allows you to view electronic documents that currently reside in the BWB Data Store.  This 
option is available on the Output menu of the main screen, and is also accessible from the Create an 
RFQ screen. 
 
Typically, multiple suppliers are invited to bid on an RFQ, so there will be multiple document in the 
BWB Data Store.  When you choose the option to View an Existing RFQ, the document for each 
supplier is opened in a separate window. 
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The documents will be displayed in either Word or PDF format, depending on the options chosen at the 
time they were created. 
 
 
Technical Notes 
You must have Microsoft Office available on your desktop computer to use the features described in this 
section.  
 
You can change the appearance of your company's Purchase Order and RFQ Documents by modifying 
the Word Document Template.  The default templates, PO.DOT and RFQ.DOT, can be found in the 
application path where the Buyer’s Workbench application has been installed.   
 
Your System Administrator may add custom fields to this application using the Buyer's Workbench 
Administration Utility.  The settings in Ncc_BWBAdmin allow you to select whether your custom fields 
are to be included on PO and RFQ documents.  Please refer to the Buyer’s Workbench Administrator’s 
Guide for more information on changing the appearance of your Purchase Order and Request for Quote 
documents. 
 
An Excel Template called po-std.xls is delivered with the application.  This is used for Purchase Orders 
only, and it produces a Packing List and Labels that may be emailed to the supplier. 
 
In order to create PDF files, you must have the full version of Adobe Acrobat installed (not just the 
reader).  If this option is grayed out, it means the application was unable to activate Adobe Acrobat.  For 
more information on Adobe Acrobat, please visit their web site at:  www.adobe.com. 
 
If you wish to send attachments as a WinZip file, you must install version 8.0 or higher of the WinZip 
software on your client computer or terminal server.  You will also need to download the WinZip 
Command Line Support Add-On from their web site:  www.winzip.com.  Once the software is installed, 
the System Administrator must use the Buyer's Workbench Administration utility to enable this feature. 
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General Information 

BWB Data Store 
The Buyer’s Workbench Data Store is a directory on the network where various electronic documents 
are stored.  These documents include: 
 

� Purchase Orders and RFQs (Word and Acrobat files) 
� Drawings and other attachments 
� Legal & Informative Documents 

 
The BWB Data Store serves as a central repository that may be accessed from both the Buyer’s 
Workbench and the Supplier Portal web site.  The root folder, or the entrance to the data store, is defined 
using the Ncc_BWBAdmin routine.  Within the BWB Data Store, sub-folders are used to organize the 
data. 
 

Document Type Format Definition 

PO Document PO_nnn_ccc.doc 
PO_nnn_ccc.pdf 

Work Document (.doc) or Adobe Acrobat (.pdf) file, where 
nnn is the PO Number, and ccc is the Change Level. 

RFQ Document RFQ_nnn_sss.doc 
RFQ_nnn_sss.pdf 

Work Document (.doc) or Adobe Acrobat (.pdf) file, where 
nnn is the RFQ number and sss is the Supplier Id. 

Drawing 
Attachment 

xxx.tif 
xxx Thumb.jpg 
xxx 11X17.jpg 

When the Buyer attaches a .TIF file, the system 
automatically converts it to .JPG format in two sizes.  A 
small (thumb) version for display on screens, and a larger 
size for printing on 11x17 paper. 

Other 
Attachments 

User Defined Any other attachments linked to the PO or RFQ using the 
Buyer’s Workbench, including Word documents, Excel 
files, etc., are stored in the appropriate PO or RFQ folder 
within the BWB Data Store. 

Company 
Documents 

xxx.pdf This Company Documents folder includes a variety of legal 
and informative documents that may be viewed and/or 
downloaded from the Supplier Portal web site.  These are 
typically Adobe Acrobat (.pdf) files. 
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Printing a Spreadsheet 
Below is a sample of the screen that will appear when you select the Print option.  Be sure to click on 
the spreadsheet you wish to print before choosing the Print option. 
 

 
 
Range - Selecting a Print Range:  You may choose to print the entire spreadsheet (all), selected cells 
(those that you have highlighted on the current screen), the current page (only the rows that are currently 
visible on your screen), or a range of page numbers.  

Orientation - Portrait or Landscape:  You may print your report in portrait mode (normal) or landscape 
mode (sideways). Printing in landscape mode will allow you to fit more columns of information on your 
report.  

Margins - Report Margins:  You can make your report more attractive by setting the top, bottom, left, 
and right margins. Reduce the left and right margins if you need to fit more columns on the report.  

Units - Inches or Centimeters?  Are the margins you entered expressed in inches or centimeters?  

Page Order:  If your report is too wide, it may span multiple pages. When this occurs, do you want the 
report printed from top to bottom or left to right?  

What Do You Want to Print?  You can customize the appearance of your report by printing (or not 
printing) column headers, row headers, grid lines, borders, shadow, and color.  
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Headers and Footers:  Your report may have up to three lines for the heading, and one line for the 
footer. The system initially displays a default heading, which you may modify if desired.    
Tip: Use /p to designate a page number.  

Which Columns Do You Want to Print?  The columns that are available for printing are listed. Select 
the columns you wish to include on your report.  

 
Importing Data from Excel 

This screen below is displayed when you choose the option to Import data from a Microsoft Excel 
spreadsheet, a tab-delimited text file, or a comma-separated text file. The data will be imported to the 
current active spreadsheet, so be sure to click on the desired spreadsheet before choosing this option. 

 

 
 

Import File Name:  Enter the path for the file that you wish to import.  You may browse the files by 
clicking on the button next to the text box. 

Header Rows:  Enter the number of rows at the beginning of the file that are not to be imported 

Import File Type:  Select the type of file that you are importing 

Data Mapping:  Enter the Column Number or Letter where data resides on the Excel file.   

Import Data:  Click OK to begin the import procedure. 
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Exporting a Spreadsheet to Excel 
Below is a sample of the screen that will appear when you select the Export to Excel option.  This will 
export the current active spreadsheet, so be sure to click on the spreadsheet you wish to print before 
choosing the Export option. 
 

 
 
Save As File Name:  Enter the pathname of the file you wish to create.  You may browse the files by 
clicking the button to locate the drive and folder where the file will be stored. 

Sheet Name:  Enter the Excel sheet name to create. This will automatically default to Sheet1. 

Export to Excel or to a File?  You may export the contents of the display directly to Excel, or you may 
choose to create a file in Excel format. 

Create a Log File?  Select this option to create a log file. The log file contains error messages and other 
information about how your Excel file was created. The name of the log file is "CreateExcelFile.log", 
and it will be stored in the same folder as your spreadsheet. 

Data Mapping:  You may move data to alternate columns by changing the column number or letter.  
You may also remove a column by removing the row that contains the column information you do not 
wish to export. 

Export Button:  After all required information has been entered, click this button to export your data to 
Microsoft Excel. 
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Editing Features 
 
Copy, Cut, Paste and Fill 
You may use the standard Windows Copy, Cut, and Paste features to copy data to the Windows 
clipboard, or to paste data from the clipboard into a cell.  
 
To copy data, hold down the left mouse button and highlight one or more cells, then choose Copy. There 
are multiple ways to enter this command:  
 

1.  From the Edit menu choose Copy. 

2.  Click the Right Mouse button, then choose Copy from the pop-up menu.  

3.  Click the corresponding icon on the toolbar.  

4.  Hold down the Ctrl key and type the letter C (Ctrl-C). 

 
You can use the Cut command (Ctrl-X) and the Paste command (Ctrl-V) in similar fashion.  
 
To copy the contents of an entire row, click once on the row header (the number displayed on the left 
side of the first cell), and then choose Copy. Now click on the row header that you want to copy the data 
to and choose Paste. 
 
If you want to update several cells with the same value, highlight all of the cells you wish to update then 
choose Fill Cells. This command will update each cell with the current information from the clipboard. 
 

Zoom 
This feature allows you to view, print and/or edit the expanded contents of a field.  It is especially useful 
for multi-line information such as notes and long descriptions. 

� You may "Zoom in" on any selected item by selecting Zoom from the Edit Menu, clicking 
the magnifying glass on the toolbar, or selecting Zoom from the right click menu.   

� The Column Name will appear in the Title Bar with "Edit" or "View".  You may edit the 
field when it is allowed.   Click OK when finished, or Cancel to revert to the original data.  

� To print the selected item, click on the printer icon and the information will be sent to your 
local printer. 

Locked fields may be viewed but not modified using the Zoom Feature.  If the field is locked, View will 
appear in the Title Bar, and there will only be a single command button labeled Done. 
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 Customizing Your Display / Arranging Columns 
Use this view to customize your display.  This information is stored in the Windows Registry, and is 
unique to each user. 
 

 
 
Each tab contains a list of fields that corresponds to a screen used in this application.  Use the 
checkboxes to show or hide each field.  
 
Use the Move Up and Move Down Buttons to re-arrange the order in which the fields appear on the 
specific screen Display. Click Reset All to return to the system’s default settings. 
 
Select the color to use for highlighting Rows that have been modified, during data entry.  This is done 
by clicking on the box Select Color for Released Rows.  By clicking on this box, the system will display 
several colors to choose from.  Click on the color you would like to use for highlighting, and then click 
OK and you will see that the Select box on the main screen has been changed to your selected color.  
Repeat this procedure to Select Color for Changed Rows, Select Color for Cancelled Rows and Select 
Color for Items on Hold. 
 
Click the Email Options button to enter parameters for sending email messages (please refer to the 
Email Options topic for more information). 
 
Select the Buyer Code to be used as the default during Purchase Order and RFQ entry. 
 
You may opt to have the system use the 1st row’s information as a default for all other line items. 
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You may opt for the system to “Remember Screen Size and Column Widths”. Any changes you make to 
the screen's appearance will be saved and applied the next time you launch this application.  
 
Choose the number of columns (from left to right) you wish to freeze on the spreadsheet. A frozen 
column will remain in place as you scroll to the right.  
 
Email Options 
 

 
 

Please contact your System Administrator if you are not sure which Transmit Method is appropriate for 
your system. 

MAPI:  Choose this option if you are running an email program on your desktop such as Outlook or 
Eudora.  Your messages will be placed in your email program's "out box" and sent in the same 
manner as your regular email messages. 

LOTUS NOTES:  Select this option if you have Lotus Notes running on your desktop 

INTERNET:  Use this option if an SMTP server has been setup for sending email via the Internet.  
If you are running this application via Citrix or Terminal Services, you will want to use the Internet 
method. 

If you wish to send a copy of the email to your email address, click on the “Always Copy To Originator” 
field and enter your email address.  This is recommended when using the Internet method to transmit 
email. 
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Wildcarding 

Wildcarding is a powerful feature that allows you to search using a portion of the field. You tell the 
system you want to use a wildcard by typing three periods “…” or an asterisk “*” at the beginning or 
end of your search entry. Here are some examples of wildcard commands and their expected results: 

Part Number:  XTR… (or 
XTR*)  

Returns part numbers that begin with “XTR”  

Description: …VALVE… 
(or *VALVE*) 

Returns parts with the word “VALVE” 
anywhere in the description.  

Category: …A (or *A)  Returns parts with a category ending with the 
letter “A”.  
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